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This document describes a new capability in RiverWare to support checking mass balance across many objects.
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1.0 Overview

The Mass Balance Summary slot is a new type of slot which can be created by the user on a RiverWare data object.
It consists of a user-defined hierarchy of series slot collections used to check mass balance across many objects in a
RiverWare model. The series slot collections are themselves series slots representing the sum of the contained slots,
and can be used within RPL expressions, and pretty much any other place where series slots are used.

There are two levels of series slot collections within a Mass Balance Summary slot:

• Water Balance -- the sum of one or more “Slot Sums”.

• Slot Sum -- the sum of one or more references to series slots in the RiverWare model -- applied in either the
positive or negative sense. “Negative” Slot Sums are subtracted from -- rather than added to -- their contain-
ing Water Balance. Only flow or volume (unit type) series slots having the model run timestep size can be
included in a Slot Sum. References to RPL expression slots are supported for entities not represented by
existing RiverWare slots.

New slot type icons represent: (1) the Mass Bal-
ance Summary Slot, and (2) The Computed
Mass Balance Slots (i.e. Water Balances and
Slot Sums).

The Computed Mass Balance Slots are com-
puted on demand (by the user) and at the end of
a run, immediately after the evaluation of post-run RPL expression slots. Also, a list of RPL expression slots to be
evaluated after a Mass Balance Summary slot computation can be specified. These “dependent expression slots”
can be used, for example, for annualization of mass balance summary results.

In the Open Slot Dialog for Mass Balance
Summary Slots, colors are associated with
the three levels of slot collections and refer-
ences.

The three color buttons at the top of this dia-
log function as a “legend” for the three lev-
els. Clicking on those buttons open the tree
items in the list to the corresponding level.
Also, individual collection items can be
opened and closed in the usual way -- by
clicking on the tree controls.

Computed and referenced slots can be
shown in any flow or volume units.
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2.0 Mass Balance Summary Slot Construction

2.1 Creating a Mass Balance Summary Slot

A Mass Balance Summary Slot can be created
on any Data Object. This is done in the Open
Object Dialog’s Slot menu by selecting the
“Add Mass Balance Summary” operation.
This creates a new default-named Mass Bal-
ance Summary slot.

Double clicking on a Mass Balance Summary
Slot item in the slot list shows the Open Slot
dialog for that slot.

The name of a Mass Balance Slot can be
edited in it’s Open Slot dialog; see below. The
name of the slot must be unique among all
slots on the containing data object. When the
typed name is not valid, the text in the name
entry field is shown in red.
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2.2 Configuring a Mass Balance Summary Slot

Editing the configuration of a Mass Balance Summary
Slot can be enabled (editable) or disabled (locked). It
is initially enabled on a newly created slot. Editing is
enabled or disabled with the following controls:

• The lock icon toggle button in the bottom left
of the dialog.

• The “Enable editing” item in the context menu.

• The “Enable editing” item in the Edit menu.

Right-clicking in the list outside of any defined items
(e.g. when the list is empty) shows a simple context
menu including the “Add Water Balance” operation.

The buttons along the bottom of the dialog are also
context sensitive -- their operation and enabledness
depends on the selection within the slot list. When no
items are selected, the “New” button adds a water bal-
ance to the list.

When new Water Balances or Slot Sums are created,
they are given a unique default name. The name of
one of these items can be edited “inline” by double-
clicking on the name.
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Slot Sums can be added to Water Balances, and Slot References can be added to Slot Sums using the “Add” context
menu operation or the “New” context button (below the slot list).

When adding slot references to a Slot Sum, the
slot selector dialog is shown. This supports selec-
tion of only series slots, including aggregate
series slot columns. The slot selector’s unit type
filter will be shown and initialized to “Flow”.

It is also valid to change the filter to “Volume” to
select slots which represent a non-static volume
entity -- i.e. volume slots which can be converted
to “Flow” by dividing the volume timestep value
by the timestep interval (i.e. volume per time).
(The computed results will be strange if a static
volume slot, such as Reservoir Storage, is
selected).

Including a particular series slot within a Slot
Sum multiple times is allowed -- this will result in
the values of that slots being added to the Slot
Sum’s values multiple times.
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Mass Balance Summary Slots and Computed Mass Balance Slots (Water Balances and Slot Sums) cannot be
included in a Slot Sum.

The user will need to define and refer to a RPL expression slot for any flow entity not provided as a RiverWare slot.
Here is an example of the inclusion of a “change in storage” entity of a set of static storage values.
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As mentioned above, the buttons along the bottom of the Open Mass Balance Summary Slot dialog are context sen-
sitive -- their operation and enabledness depend on the selection within the slot list. The following table illustrates
the operations provided by the first several buttons, as a function of the selected item or items. Tooltips on these
buttons provide additional information.

The “New / Add” and “Paste” operations are enabled only for single-
item selections . The “Delete / Remove” and Copy operations are
enabled on single or multiple selections when all selected items are at
the same level. The enabledness of the “Paste” operation depends also
on the type of items (Water Balances, Slot Sums, or Slot References) in
the clipboard. The user must confirm “Delete / Remove” operations.

The up and down arrows move the selected items up or down within the
set of “sibling” items. They are enabled only when the selected items are all at the same level.

The “Set” (Plus) and (Minus) buttons affect the Slot Sums within the set of selected items. When the mass balance
summary is computed, the values of “positive” Slot Sums are added to the containing Water Balance; the values of
“negative” Slot Sums are subtracted.

The only context button which is enabled when
editing is disabled (locked) is the “copy” button.

Different context menus are displayed within the
slot list, depending on whether editing is enabled or dis-
abled.

The configuration of dependent RPL Expression slots is
described in a subsequent section.
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3.0 Mass Balance Summary Internal Display Operations

Similar to the Open Object dialog box, the
Open Mass Balance Summary Slot dialog
shows a single series value -- at one timestep
-- of all contained series slots. The timestep
date/time is set by the Date/Time spinner.

Note: All Water Balances, Slot Sums
and Series Slot references have the
same timestep size -- that of the
model run. Water Balances and Slot
Sums are computed for the model run
interval.

As currently implemented, a global time
scroll cannot be initiated from this dialog,
but a global time scroll performed elsewhere
will set the date/time of this dialog.

The Open Mass Balance Summary Slot dia-
log does not support editing of any series
values. Of course, all computed sum values
are “read only”.

Series values can be displayed in any Flow or Volume
units in this dialog. (Volume values are converted to
flows by dividing by the timestep interval, which can
be specific to the particular timestep date/time in the
case of monthly and annual series). The available Flow
and Volume units are determined by the external Riv-
erWare “units” file.

The individual settings for Flow and for Volume units
are separately retained. That is, clicking the Flow and
Volume toggle button switches between the most
recently selected unit for of those two unit types.

The selected unit type and unit is both a display setting
and a configuration setting: when the mass balance
summary is computed, the computed slots are recon-
figured with these units. This works except when the
computed results (Water Balances and Slot Sums) are
referred to from RPL expressions which require these
slots to have one particular unit type. This is an issue for any such RPL expressions -- including, but not limited to
those in the Dependent Expression Slot list associated with a mass balance summary. Unit type incompatibilities
will be reported by the RPL expression evaluation mechanism in the usual way.
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As previously mentioned, the colored level buttons function to open the entire tree to the indicated level. Of course,
individual tree items can be opened or closed by clicking on the standard tree controls.

The “View” menu provides operations
which effect data display within this
dialog.

The “Adjust Width” operation fits the
slot list’s column widths and the overall
dialog width. This adjustment is auto-
matic for certain dialog operations, but
not all (e.g. not when opening and clos-
ing individual tree items).

In general, the units column in the slot
list can be hidden. But, in the usual cir-
cumstance that slots having different
unit types (other than flow and volume)
somehow show up in the list, units are unconditionally shown and the option to hide the units column is disabled.

Use of the three “Show Series Values” toggles is illustrated on the following page.
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Especially when items from all three levels are displayed, the user may want to hide values at any of those levels, so
that only comparable values (at the same level) are displayed:
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4.0 Mass Balance Summary External Display Operations

From the Open Mass Balance Summary Slot dialog, the user can:

• Show selected slots in their Open Slot Dialogs

• Show slots -- either “visible” (in the tree), or “selected” -- in a new SCT or in the single open SCT.

• Plot the selected slots.

• Copy selected slots, e.g. to an Output Device or to the Snapshot Manager.

4.1 Show Computed Slots in an Open Slot Dialog

As currently implemented, Water Balances are generated as Agg-
SeriesSlots with the Water Balance’s Slot Sums generated as series
slot columns on that AggSeriesSlot. In the “editing-disabled” version
of the context menu, the “Open Slots ...” item shows the Open Agg-
SeriesSlot Dialog for the selected computed items -- and the appropri-
ate Open Slot dialog for any of the selected referenced series slots.
When operating “Open Slots ...” on a selected Slot Sum, the Open Slot
dialog for the containing Water Balance (AggSeriesSlot) is shown, and the column corresponding to the selected
Slot Sum is selected. Before opening more than five (5) Open Slot dialogs, the operation is confirmed with the user.

Note that there is currently no indication of the Slot Sums’ “sense” being positive or negative. Values are displayed
with a crosshatch indicating that they are “read-only” (non-editable). Notice, in the image above, the not-quite-zero
value in the “Value” line edit field from the single selected cell (upper left cell) -- this sort of value will be typical of
actual computed Water Balance values. Enabling the display of the selection statistics (from the View menu) and
selecting the first column provides a convenient way to determine whether or not the whole Water Balance series is
approximately zero.
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4.2 Show Slots in an SCT

Computed summary and referenced
slots can be shown in an SCT. If a sin-
gle SCT is open, slots from the Mass
Balance Summary dialog can be
added to that SCT. In the latter case,
this will work as desired only if that
single open SCT has the same
timestep size as the model run.

The operations to show slots in an
SCT are available in the dialog's
“File” menu and in the non-editable
(locked) context menu.

The “File” menu’s “Show Visible
Slots in New SCT ...” shows all slot
items currently visible in the slot list
(i.e. excluding those hidden under a
closed tree branch).

Water Balance and Slot Sum slots are shown with the values and units set at the time of the most recent mass bal-
ance computation -- i.e. not necessarily the current unit setting in the Open Mass Balance Summary Slot dialog. If
referenced slots are including in the “show in SCT” operation, they will be shown with their currently configured
(or “active”) units. And if they are editable slots, they will be editable in the SCT. (Notice the rows in the image
above which are not cross-hatched -- those series values are directly editable).
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4.3 Plot Slots

Computed summary and refer-
enced slots can be plotted in a sin-
gle plot. Those operations are
visible in the menus shown in the
prior section. The note above
regarding the active units of com-
puted and referenced slots applies
also to Plots -- i.e. the units used
will not necessarily be those of the
current settings in the Open Mass
Balance Summary slot dialog.

Note that the current RiverWare
plot device isn’t particularly smart
in dealing with units. Only slots
having two of the unit types and
units represented in the set of slots
being plotted actually show up.
Those two units are assigned to the
left and right axis, but no attempt is
made to line up the vertical values
of those axis even if they are of the
same unit type! (And certainly no
attempt is made in the Plot device
to align flow values with volume
values).

The accompanying image does not
demonstrate the limitations and
problems described above.

Note also that all values are plotted
in their positive (actual) sense -- values in negated Slot Sums are not shown as negated values. (Actually, this is cur-
rently true of all Slot Sum value displays -- even in the Open Mass Balance Summary Slot dialog).

4.4 Copy Slots

Computed summary and referenced slots can be copied to the RiverWare Slot Clipboard. From there, they can be
pasted into various slot lists in RiverWare, including the general Output Device slot list and the Snapshot Manager
slot list.
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4.5 Examining the Mass Balance Summary Slot’s Series

The Mass Balance Summary Slot is itself a series slot (contained on a data object). In general, each of the Mass
Balance Summary Slot’s top level items -- Water Balances -- are expected to “zero.” So should their sum; the Mass
Balance Summary Slot’s series is that sum. This may not be fundamental to any given application of the mass bal-
ance summary capability, but it is available.

The Mass Balance Summary Slot’s series can be examined by clicking on the Mass Balance Summary Slot icon
button at the top of the dialog. (In a sense, a Mass Balance Summary Slot has two different “open slot” dialogs).

In the plot above, notice how all of the values represented on the vertical axis are zero (to a precision of five frac-
tional decimal digits), in this example.

In both of the “open slot” dialogs illustrated above, the data object icon is a button which shows the Open Object
dialog for the containing data object.
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5.0 Dependent RPL Expression Slot Support

Mass Balance Summaries are designed in such a way that intermediate and final sum results (Slot Sums and Water
Balances) are usable within custom user calculations implemented in RPL Expression Slots. The initial application
of Mass Balance Summaries implements annualization of summation series with this capability.

In fact, a mass balance calculation involving 560 physical slots implemented by the URGWOM team using only
RPL served as a prototype for this built-in Riverware capability. This included an additional dozen RPL Expression
slots to annualize the computed daily timestep sums. Given the iterative re-evaluation mechanism within RPL, the
RPL implementation was able to guarantee that the dependent annualization RPL Expression slots were recom-
puted when any RPL Expression slots on which they depended were recomputed.

Re-implementing the basic mass balance computations in C++ effectively breaks this guaranteed correct reevalua-
tion of dependent RPL Expression Slots. To address the loss of this behavior, special support for a “Dependent
Expression Slot List” was added to Mass Balance Summaries.

The “Dependent Expression Slot List” in a Mass Balance Summary is evaluated, in order, once through, each time
a Mass Balance Summary is computed.

Dependent Expression Slot results will generally be incomplete when computing a Mass Balance Summary if the
RPL Expression Slots in the List depend on sums from multiple (distinct) mass balance summaries. (This is true of
the URGWOM annualization computations). The following provisions were introduced to address this problem:

• The automatic “end-of-run” mass balance computations are
performed in this order:

1.The RPL Expression slots in the Dependent Expression
Slot Lists in ALL Mass Balance Summaries in the
model are cleared. (This is done to insure determin-
istic results in case any of these slots are mistakenly
included IN a mass balance summary Slot Sum).

2.All Mass Balance Summaries are computed.

3.The RPL Expression slots in the Dependent Expression
Slot Lists in ALL Mass Balance Summaries in the
model are evaluated.

• A “Compute All Summaries” menu operation which per-
forms this model-wide computation (the three steps outlined
above) is provided in the “File” menu of the Open Mass Bal-
ance Summary Slot dialog. See image to the right.
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The Dependent Expression
Slot panel at the bottom of the
Open Mass Balance Summary
Slot dialog implements editing
and data display operations
similar to those of the main slot
list.

Note that if the Dependent
Expression Slots are used for
annualization computations --
with an annual timestep being
different from the model’s run
timestep, they can’t be dis-
played in the same SCT as the
computed summary slots and
slot references.

Clicking the “Add” button in
the Dependent Expressoin
Slots panel brings up the Slot
Selector, initialized with “Has
RPL Expression” and “Unit
Type” (“Flow”) filters turned
on. Any one RPL Expression
slot can appear in the depen-
dent expression slot list only
once.

The order of slots in this list is
significant -- it is the evaluation
order. The selected slot items
can be moved up or down in
the list with the up and down
arrow buttons.

The selected dependent slot
items can be removed from the
list by clicking the “Remove”
button.
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6.0 Mass Balance Summary Computation

Mass Balance Summary Computations are performed in these ways:

1. By clicking the “Recompute” button in the Open Mass Balance Summary Slot dialog.

2. By selecting the “Compute All Summaries” operation in the “File” menu of that dialog.

3. Automatically, at the end of a run, immediately after the “end-of-run” RPL Expression Slots evaluation. This is
performed unconditionally.

Note: We decided to not provide a conditional configuration setting for this, as the computation runs very
quickly -- e.g. about half a second for a 4000-timestep version of the URGWOM calibration model, sum-
ming about 560 physical slots in a debug build in Visual Studio. [64-bit Intel Core i7-2600 CPU @ 3.4
GHz; 16 GB; Windows 7; DELL OptiPlex 990].

The latter two methods compute all mass balance summaries within the model, with processing of Dependent
Expression Slots both before and after (clearing and re-evaluationg) the mass balance summary computation. (See
the prior section).

As a tool for debugging and testing Mass Balance Summary implementations (including user definitions), opera-
tions to clear an individual Mass Balance Summary, and all Mass Balance Summaries (including Dependent
Expression Slots) are provided in the “File” menu of the Open Mass Balance Summary Slot dialog.

6.0.1 Computation Detail

AggSeriesSlots are dynamically maintained for each Water Balance, with AggSeriesSlot columns (series slots) cre-
ated for each Slot Sum within the Water Balance. As an initial step in the Mass Balance Summary computation, the
instantiation of these slots is assured, and their timestep size and timestep range is set to the step size and time
range of the run controller. Also, the unit type and configured display units are set to those last applied by the user
in the Open Mass Balance Summary Slot dialog (by clicking “Recompute”). For each timestep in the run time
range, any of the contained slots having a valid value at that timestep contributes that value to the Slot Sum or
Water Balance’s value at that timestep. NaNs are ignored (effectively zero). The computed slots are set to be “read-
only” -- not editable by the user.

6.0.2 Limitations of the current Mass Balance Summary Computation:

1. No “routed terms”. A timestep offset cannot be applied to any slot reference within a Slot Sum, nor to any Slot
Sum within a Water Balance.

2. No knowledge of “static volumes”. The mechanism unconditionally converts all volumes to flows by dividing
the volume by the timestep size (at each timestep, to yield a volume-per-time value). For static volumes, it
would generally be reasonable to instead subtract the value at the prior timestep from that of the current
timestep to compute a “change in storage” entity. However, it doesn’t seem that that computation could uncon-
ditionally be applied in the “volume” domain (though sometimes that would be correct). A RPL implementa-
tion of the “change in storage” calculation can be seen in this document, in section 2.2 (though, apparently
negated from the natural representation of that entity).

Currently, to accommodate either of these sorts of computations, the user can define a RPL Expression slot for use
as a term in a Slot Sum.
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7.0 Persistence

All Mass Balance Summary configuration information is stored on the Mass Balance Summary Slot -- in an
instance of the Sim/MassBalSumConfig C++ class; this instance is maintained within the Slot class (not SeriesS-
lot). The Tcl-based Slot serialization incorporates an XML-based MassBalSumConfig instance, when one exists on
the Slot. This is applied both in the RiverWare model file and in Export SimObj (data object) files.

A Mass Balance Summary Slot’s computed Water Balance AggSeriesSlots (along with the contained Slot Sum
SeriesSlots) are created as (effectively) invisible slots on the same data object as the generating Mass Balance Sum-
mary Slot. (These aren’t “invisible” in the ordinary sense -- they do show up in the RiverWare “GUS” Slot Selector,
e.g. for use in RPL Expression slots). The computed AggSeriesSlots DO persist in the RiverWare model file -- but
not in Export SimObj (data object) files.

As needed for support for the GUI implementation of the Mass Balance Summary tree view, both item selection
and tree open/closed states ARE part of the MassBalSumConfig serialization. An unimportant implication is that,
after saving and reloading a model with Mass Balance Summary Slots, when re-opening one of these slots, the
prior tree open/close states AND the item selection are restored!

A Mass Balance Summary Slot’s configuration (MassBalSumConfig) can also be saved to, and read from an XML
file using the Export and Import operations in the Open Mass Balance Summary Dialog’s “File” menu. Below is an
example of one of these XML files:

--- (end) ---
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